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Section 1 - Spectroradiometer

1. INTRODUCTION
The GER 1500 is a field portable spectroradiometer covering the UV, Visible, and NIR wavelengths
from 350 nm to 1050 nm.  It uses a diffraction grating with a silicon diode array.  The silicon array
has 512 discrete detectors that provide the capability to read 512 spectral bands.  The
spectroradiometer includes memory for stand alone operation as well as capability for computer
assisted operation through its COM2, RS232 serial port.  Up to 483 spectral readings can be stored
for subsequent down loading and analysis using a personal computer with a standard RS232 serial
port and GER licensed operating software. Computers incorporating only USB serial ports may be
connected to the GER 1500 by using the SVC ADP000015 USB Serial port adapter. Instructions for
use of the adapter are provided in Appendix J of this manual.

An optional external GPS device may be connected via the instrument’s COM1 RS232 serial port.
When connected, GER 1500 records the latitude, longitude, and time of each spectral reading.

This instrument is self contained and incorporates an easily replaceable battery called a
SMARTPACK.   A battery charger is supplied with the GER 1500 and has the capability to
simultaneously charge two (2) SMARTPACKs from line voltage with the AC adapter provided.

The PC based (Windows OS) operation allows for real time data display and data analysis.  Radiance
and percent reflectance are provided within the acquisition software.

A PDA option is also available. The PDA may be used to conveniently acquire and examine spectral
data under field conditions without the bulk of a laptop. The PDA may also be configured with an
internal GPS device to provide coordinates with every scan.

A full range of options are available for the GER 1500. These options include alternate collection
optics, a fiber optic system, a diffuser, an underwater housing enclosure, and a dedicated GPS
receiver.

2. HARDWARE DESCRIPTION

Tripod Mounting Plate

The tripod mounting plate is conveniently located enabling the spectroradiometer to be mounted on
a tripod.  The mounting plate on the bottom of the instrument has a 1/4 20 NC threaded hole that is
compatible with most conventional photographic or video tripods.

Trigger Switch

The trigger switch can both actuate the sighting laser and initiate the start of the spectral scan. (More
detail is provided in the Control Panel Section.)

Lens Barrel

The lens barrel screws into the unit and is easily removed.  The following typical collection optics are
available:

      (1)  Standard (4° Nominal)
      (2)  Fiber Optic Option
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      (3)  8° field-of-view (FOV) Option
      (4)  Diffuser Option (white flashed opal providing close
           to ideal Lambertian distribution)

NOTES:  When any of the field-of-view collection optics are installed or changed, the proper radiometric
corrections can be applied by the software.  The entry of this information is provided for in the Control Setup software
section of the manual, and the “OPTIC” menu item within the instrument itself.

Battery Pack

The removable battery pack is the source of power for the spectroradiometer.  The battery pack,
known as the "SMARTPACK," is a nickel metal hydride battery especially designed and fabricated for
this application.
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3. CONTROL PANEL
The control panel of the GER 1500 contains the controls and displays that are required for the stand
alone operation of the instrument.

Serial Port
GPS

Serial Port
Computer  Operation

Power “On”
Switch

Power “On”
Indicator

Laser “On”
Indicator

Data Connections

The Control Panel has 2 connectors that may be used to communicate with external devices:

COM1  The COM1 port is for an optional GPS device. See Appendix F
for a complete description of this option. This connection is also
used with the optional underwater housing.

COM2 The COM2 port is for computer assisted operation.

Indicators

The Control Panel has 2 red LED status indicators.

Power LED The power indicator is illuminated when the power is on.

Laser LED The laser indicator is illuminated when the laser is on.

Membrane Switches

The five (5) diaphragm membrane push button switches provide control of the unit and the capability
of observing its operation. The functions of the switches are provided in the table on the following
page.
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Switch Scan Mode Edit Mode
Power Turns the system on or off

Menu
Steps through parameter

menu

Resets the parameter shown to
one (1) when depressed except
when Intsp (Integration speed)
parameter is displayed. Mode of

operation is toggled between
automatic and manual.

Selects the scan type and
refreshes battery readings

Increments the value of a selected
parameter

Selects the scan type. Decrements the value of the
selected parameter.

Edit Toggles between Edit and Scan Modes

LCD Display

The LCD display is an eight (8) digit, two (2) row display that shows the selected scan and status
messages.

ROW 1 Row 1 displays the scan types, status messages, and battery voltage.  The
scans are selected by using the up-arrow and down-arrow  buttons when
in scan mode.

Scan Types:

REF x.xx Indicates that a spectral measurement will be stored as
a Reference Scan.

TAR x.xx Indicates that a spectral measurement will be stored as
a Target Scan.

x.xx x.xx displays the battery voltage.

Status Messages:

SCANNING SCANNING indicates that a spectral data acquisition
is being performed.

**SAT** **SAT** indicates that the detector saturated during
the previous scan.

LOW BAT LOW BAT indicates that the battery is below the 6.0
Volt operational limit.

READY READY indicates that the "Trigger" switch has been
depressed and the GER 1500 is ready to acquire data.

BUSY BUSY indicates that the GER 1500 is communicating
with the computer
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ROW 2 Row 2 displays the parameter menu as well as some additional status
messages.

The parameter menu is scrolled by depressing the MENU button. The
parameters AVG, MEM, INSTP, TRG, and OPTIC can be adjusted.

In addition to the parameters listed above, the status of the optional GPS
device may also be displayed using the MENU button.

Parameter Menu:

MEM xxx MEM xxx is the memory slot that stores the
acquisition. The allowable values are from 1 to
471.

AVG x AVG x is the averaging value. The allowable
values are from 1 to 9. The number of detector
scans to be averaged is 2(x-1).

INSTP mx In INSTP mx, the m represents the integration
mode and the x represents the integration
speed.

The normal mode of operation is Automatic.
When m is represented by an “A”, this indicates
that the integration speed is in Automatic Mode.
To change to or from Automatic integration
mode, press “Menu” when in edit mode.

When m is represented by a “blank space”, this
indicates that the integration is in manual mode
and the user must properly adjust the
integration speed for the current light
conditions.

The allowable values for x are from 1 to 6. The
shortest integration time is 5 milliseconds. The
approximate integration time in milliseconds for
each value can be approximated by 2(x-1)*5.

TRG cccc The “Trigger Switch” can be used to activate
the laser when depressed and/or initiate a scan
when released. The trigger switch has the
following operational modes:

BOTH – The trigger activates the laser when
depressed and begins the acquisition when
released.

SCAN – The trigger does not activate the laser
when depressed, but begins the acquisitions
when released.

LSR – The trigger activates the laser when
depressed, but does not begin an acquisition
when released.
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OPTIC x Entrance optic options have allowable values of
1 through 12. Typical values for optics 1
through 5 are listed below; values for optics 6
through 12 are used for other optional
foreoptics.

(1) Standard (4˚ FOV)
(2) Fiber Optic option
(3) 8˚ FOV option
(4) Diffuser option
(5) Unity

Status Menu:

GPS xxxx Displays the current status of the optional GPS
device attached to the instrument, as described
below:

OK – the GPS device is attached, is locked
onto enough satellites to produce
position data, and that position data is
being received correctly by the GER
1500.

NONE – no GPS data is currently
available; check that the GPS device
is set up and functioning correctly.

Note that while the GPS status is displayed on
the LCD, the EDIT key may be pressed to
refresh its status.

During scanning, the current GPS status is also
briefly displayed in the LCD.

Modifying a parameter

(1) Depress the EDIT button to enter edit mode. A
blinking cursor appears in the eight character
position of the second row.

(2) Modify the parameter by depressing the up-arrow
or down-arrow buttons. The push button switches
are programmed to increment or decrement by a
single depression or when held in to scroll rapidly
through the parameter setting. Parameters can be
set to a default value (1) when the switch is pressed
(except INTSP).

(3) Depress the EDIT button to exit the EDIT mode
and save the selected parameter setting.



GER 1500 USER MANUAL, REVISION 3.7

G E R  1 5 0 0  S P E C T R O R A D I O M E T E R  7



GER 1500 USER MANUAL, REVISION 3.7

G E R  1 5 0 0  S P E C T R O R A D I O M E T E R  8

Section 2 – PC Data Acquisition Software

1. INSTALLATION
The GER 1500 PC Data Acquisition Software is a supplied on one of two media – CD, or 1.44 MB
Floppy.

Installation is always a two-step process:

• The installation media is used to install the PC Data Acquisition software into an installation
directory (typically, C:\Program Files\Spectra Vista\Ger1500\) on the computer’s hard drive.

• The “System” folder, which contains information that is specific to your particular GER 1500
instrument, must then be manually copied into the installation directory. This “System” folder is
supplied on a separate CD or floppy, and is not included on the installation CD.

After the “System” folder is copied to the installation directory, the initialization file “GER.INI”
must be edited in order to configure the installation for your particular PC. Typically, the PC’s
communication port - used to connect to the GER 1500 instrument - must be specified.  See the
section “Initialization File Format” in Appendix B for more details.

CD Installation

To install the software from CD, simply insert the installation CD into the CD drive in the computer
where you want to install the software. A screen similar to the one shown below will appear in less
than 1 minute. Follow the on-screen prompts to install the PC Data Acquisition software.

When the installation completes, remember to copy the “System” folder associated with your
instrument’s serial number into the installation directory, before running the PC Data Acquisition
software for the first time.

After copying the “System” folder to your hard disk, please ensure that the file “ref.dat” is not
marked “Read only”:

• Use Windows Explorer to look at the contents of your GER 1500 “System” folder on your hard
disk.

• Right-click on the “ref.dat” files icon, and select “Properties”; a properties window will pop-up.

• Examine the “Read-only” attribute near the bottom of the pop-up window; there should not be
a check mark. If there is, un-check the box and dismiss the pop-up by pressing “OK”.
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If the screen shown above does not appear within 60 seconds:

• Use Windows Explorer to explore the CD.

• Double-click on the “setup.exe” file located on the CD in order to manually run the setup.

Floppy Installation

To install the software from floppy, insert “Disk 1” into the computer’s floppy disk drive. Use
Windows Explorer to explore the floppy. Double-click on the “setup.exe” file. The screen shown
above should appear within 1 minute. Follow the on-screen prompts to install the PC Data
Acquisition software.

Note that depending on your operating system, the installation program may not ask you to insert
all of the floppy disks supplied for installation purposes.

When the installation completes, remember to copy the “System” folder associated with your
instrument’s serial number into the installation directory, before running the PC Data Acquisition
software for the first time.

After copying the “System” folder to your hard disk, please ensure that the file “ref.dat” is not
marked “Read only”:

• Use Windows Explorer to look at the contents of your GER 1500 “System” folder on your hard
disk.

• Right-click on the “ref.dat” icon, and select “Properties”; a properties window will pop-up.

• Examine the “Read-only” attribute near the bottom of the pop-up window; there should not be
a check mark. If there is, un-check the box and dismiss the pop-up by pressing “OK”.
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2. INTRODUCTION
The GER 1500 PC Data Acquisition Software provides the user with a flexible, easy to use software
package.  The GER PC Data Acquisition Software is used to acquire data from the GER 1500, store
data to files on disk, and display data graphically.

The Acquisition Software can modify spectroradiometer parameters, read battery voltage, take
spectral measurements, and download spectral measurements from the on board memory of the
GER 1500 to files on disk.  The Acquisition Software allows data to be configured and stored to a file
on disk when taking a spectral measurement.

The software has a number of features that provide a great deal of flexibility for data storage:

• Data files can be configured as Sig Files for use with PC Data Acquisition Software.
• Data files can be configured as user defined ASCII Files for export to other software

packages.
• Data files can be automatically created and given an incremental extension at the end of

the acquisition.
• Data can be saved to a unique file name at the end of the acquisition.
• Data can be evaluated and saved to a file at a later time.
• The two types of graphic displays are as follows
• The single graph which displays the Reference and Target Radiance on the left Y axis

and the Percent Reflectance on the right axis for one measurement.
• The multi graph which displays the Percent Reflectance of up to ten measurements on

one graph.
     

The real time display of a computer measurement can be configured to display the data in one graph,
both graphs, or no graphs.

The PC Data Acquisition Software’s initial screen is shown below.
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The screen above is divided into several areas, as
described below:

The main menu allows the operator to open/save files
and configure both the instrument settings and the
display of spectral data. Each menu item is discussed in
detail in subsequent sections.

The Reference button causes the instrument to take and
graphically display reference data.

The Target button causes the instrument to take and
graphically display target data.

The File Stack area shows the list of data files that are
currently open. It also allows the operator to select
which files to graph in single-graph mode by double-
clicking.

The Plot Type area allows the operator to select the
type of data displayed in the graph area.

The Status Bar area displays the channel number, the
wavelength, and the Radiance/ Reflectance value of a
selected data point on a displayed graph.

A data point in a graph is selected by moving the cursor
to the point of interest, and left-clicking on the point.

(Graphing Area)

The large white area displays single-graph or multi-
graph data sets. The Graphing Area operates in two
modes, Zoom Mode and Normal Mode.

ZOOM MODE: A rectangular area of interest may be
magnified by holding down the left mouse button while
“dragging” a rectangular area across the graph. When
the left mouse button is released, the graph is re-drawn
to contain only the dragged rectangle.

NORMAL MODE: Click the right mouse button
anywhere in the graph area to restore the magnification
to normal.
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3. DESCRIPTION

Menu Selection Summary

 File Provides a menu of options pertaining to Data Files.

Control Provides a menu of options to control Spectroradiometer
operations.

Options Provides a menu of available options for Real Time Display of
spectral measurements.

Window Provides a menu of available Window displays and settings.

  About  Provides a dialog box of software and spectroradiometer data.

File

The File menu item provides the following drop-down menu of file controls.

NEW Modifies the filename configuration used for storing spectral
response measurements when the ‘Autosave’ feature is being used.

The following standard Windows file dialog box appears when “New” is selected.
Note that the dialog style may vary slightly with different versions of the Windows
OS.
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File name Modifies the Base of the filename used with the Autosave
feature. The filename of a spectral measurement acquired
in Autosave mode is the File Base with an incremental
extension automatically provided by the software.

Ex. If the file base is “Test”, the first filename is
“Test_000.sig”, the second is “Test._001.sig”, etc…

When entering the new base name into the File name
box, do not include any filename extensions, as the
software will automatically add the appropriate extension
as each data set is acquired.

Files list Displays the files that exist in the current drive, directory,
and search pattern.

File of type This box has no purpose other than to display
instructions to the user.

Open Accepts the new base file name entered.

Cancel Cancels the operation.
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OPEN Opens the files to be displayed in multi-graph.

The following standard Windows file open dialog box appears when “Open” is
selected. Note that the dialog style may vary slightly with different versions of the
Windows OS.

File name Selects the file(s) to be opened. A single mouse click
selects a single file or <Ctrl> + click or <Shift> + click
can be used to select multiple files.

NOTE: The multi-graph is limited to sixteen (16) plots.

File Type Modifies the current search pattern used for displaying
the existing files in the Files Box. Only “sig” format files
may be opened by the PC Data Acquisition software.

Open Opens the selected file(s) for display in the multi-graph.

Cancel Exits the dialog box without opening a file.
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SAVE AS … Saves the data that is currently contained in the single
graph. In order to use the Save As… function, the
graphing software must be in Single Graph mode,
displaying the data file that is to be saved.

The following standard Windows file save dialog box appears when “Save As” is
selected. Note that the dialog style may vary slightly with different versions of the
Windows OS.

File name Allows the desired filename for data storage to be
entered. If no extension or an invalid extension is
entered, then one is supplied, based on the current file
format.

Files Displays the files that exist in the current drive, directory,
and search pattern.

Save As Type Modifies the current search pattern used for displaying
the existing files in the Files Box. Only the currently
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selected format may be saved. The file format is selected
by using the File->Data Options->Format menu to
choose between “sig” and “ascii” output file format.

Save Saves the data contained in the single graph to the
specified filename and exits the dialog box.

Cancel Exits the dialog box without saving the file.

CLOSE Closes the data files that are selected in the File Stack of the multi-
graph. The multi-graph is redrawn after the files are closed.

PRINT Opens a standard Windows print dialog box. The current graph
view may be printed using this dialog.

DATA OPTIONS Configures how and when spectral measurements are stored to a
files on a disk.
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Autosave When this item is checked, the Autosave feature is
turned on. When Autosave is on, spectral
measurements are automatically saved to files on
disk using the Files Base and an incremental
extension. The default filename configuration uses
the installation data directory (typically C:\Program
Files\Spectra Vista\Ger1500\Data\) and the Files
Base determined by “gr” and the month, day, and
year (Ex. “gr052105”).

When the Autosave is turned on, the Prompt For
Save option is disabled.

Prompt For Save Prompts for a filename to store the data after the
completion of a spectral measurement.

Multi Graph Indicates the current spectral data display mode,
either “Multi Graph” or “Single Graph”.

Format Configures the data output file.

Choosing “Format” displays the following dialog box:

FILE FORMAT Provides for the selection of one of the following:

• Sig File This is the format compatible with the
Ger1500 PC Data Acquisition software;
spectral data saved in this format may be read
back and displayed at some future time by the
Ger1500 PC Data Acquisition Software

• Ascii File  Check the column(s) of data that will
appear in the ASCII data file. The options are:

Header information, including
instrument settings, date/time, etc.

Wavelength in nanometers

Reference Radiance in
W/cm2/nm/sr*1010

Target Radiance in
W/cm2/nm/sr*1010

Percent Reflectance
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OK Implements the selected file format and exits the
dialog box.

Cancel Ignores the modifications made to the file format
and exits the dialog box.

EXIT Exits the program.

Control

The control menu item provides the following drop-down menu of instrument
controls:

SETUP Configures the Computer Port used for communications and
sets the GER 1500 spectroradiometer parameters and timer function.

When selected the following occurs prior to opening the setup dialog box.

1. The computer's communications ports, as specified in
the GER.INI configuration file, are checked for
availability.  An error message is displayed if the
selected COM port is not available.  The Setup Dialog
Box activates with the Computer Port Frame enabled
and the Spectroradiometer and timer frames disabled.
Disabled functions appear in gray.

2. Communication to the spectroradiometer is checked.
If the instrument responds, the Computer Port Frame
is disabled, the instrument parameters are read and
displayed in the enabled Spectroradiometer frame and
the timer frame is enabled.  If the instrument does not
respond, the error message dialog box appears and
only the Computer Port Frame is enabled.

When "Setup” is selected, the following dialog box appears:
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Computer Port Frame Sets the serial communications port
of the computer when enabled.

  
Spectroradiometer Frame Modifies the spectrometer

parameters when enabled.

Entrance Optic Typical default optics are:

       •  Standard, 4° FOV
      •  Fiber Optic
       •  8° FOV
    •  Diffuser
      •  Unity Function

This selection should reflect the
optic that is currently in use.  The
software uses the Radiance
Calibration File for the selected
optic for measurements collected by
the GER 1500.

Up to 12 custom entrance optic
options and optic names may be
configured by using the optional
System file “foreoptics.cal”. See
Appendix B, FILE
DESCRIPTIONS, Custom
Foreoptic Configuration for more
information.

NOTE: The Unity Function
provides raw measurements without
radiometric calibration applied.

Averaging Modifies the GER 1500 averaging
parameter.
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Date Displays the current date stored in
the GER 1500 real time clock. If the
displayed date is changed, the new
date is downloaded to the GER
1500 if the “OK” button is selected.

Time Displays the current time stored in
the GER 1500 real time clock. If the
displayed time is changed, the new
time is downloaded to the GER
1500 if the “OK” button is selected.

Timer Frame Acquires a target measurement after
a specified number of seconds pass
from the previous measurement.
This occurs if the "OK" button is
selected and the timer enabled box is
checked.  This continues until the
Timer Enable Box is unchecked or
until an error occurs.

The Autosave Option (See “File
Data Options” above) automatically
saves all timer measurements when
checked, otherwise a "Save to File"
dialog will appear allowing only
selected scans to be stored.

OK Implements the selected format,
repeats the previous setup actions
listed above in 1 and 2, and exits the
dialog box.

Cancel Exits this dialog box without saving
any modifications to the setup
setting.

READ MEMORY Reads (downloads) the GER 1500 memory scans to the computer.

When selected, the Read Memory command executes the following
sequence:

1. Communications to the instrument are checked.  An
error dialog box shows if communications fail.

2. The number of scans in the GER 1500 memory and
the default filename for the first data file are displayed
in the following window:
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OK Proceeds with the operation, downloading the selected
scans from the GER 1500 to the computer.

Stores measurements from the GER 1500 memory
into the current drive and data file directory of the
GER data acquisition program with an incremental
extension given to the file base.

The GER 1500 LCD displays the BUSY status
message for each reading.  A data file is created for
each target scan (NOTE: No files are created for
reference scans.) A sig file contains the radiance of the
target scan and the radiance of the most recent
reference scan.  The memory slots of the scans are
recorded in the file header.  (See Appendix B for
further description.)

When all data are downloaded a message box indicates
that the operation is complete.

New File Name Displays the same dialog box that appears when
choosing "File" then "New."  This allows the change in
the filename configuration

Cancel Cancels the read memory operation.

First Scan Changes the first scan to be read.

Last Scan Changes the last scan to be read.

Edit Scan Types A check in the box prompts (see below) the operator
for the scan type for every scan read from the GER
1500.  This option may be used if, for example, a target
scan was accidentally taken as a reference scan.
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 Yes Allows a change to be made

 No Reads the scan as the type shown.

 Cancel Cancels the operation.   

SYSTEM VOLTAGES This function displays the following system voltages: +6 Volt battery,
±15 Volt regulator, and 5 Volt regulator.

The 1500 instrument requires a minimum of 6 volts for
operation.  The rest of the information in the window (below) is
for diagnostic purposes only.

When choosing "System Voltages," the following dialog box appears:

Options

The Options menu allows the operator to choose whether target scans are displayed in a
Single-Graph or Multi-Graph Window.

Target scans are displayed in one of 4 possible ways depending on which option is checked:

NONE Target scans are not displayed in a graph as they are acquired.
SINGLE Target scans are displayed in a Single-Graph Window as they are

acquired.
MULTI Target scans are displayed in a Multi-Graph Window as they are acquired.
BOTH Target scans are displayed briefly in Single-Graph Window,  and then are

added the Multi-Graph Window.

Window

The Window item provides a menu of available window displays; it allows the operator to
switch back/forth between the two types (Single- and Multi-Graph) displays, and allows the
operator to control some characteristics of the graph (line width, data markers, etc.)
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SINGLE GRAPH Displays the currently selected file in a Single Graph.

The measurement’s Reference and the Target Radiance are scaled
against the left Y axis and the Percent Reflectance
(Target/Reference *100) is scaled against the right Y axis.

  An example of this is shown below:
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The graphs shown in the example above are:
  Reference Radiance (Red)
   Target Radiance (Yellow)
        % Reflectance (Black)

Each of these is displayed as a function of wavelength.  The text box in
the lower portion of the window displays the file header information.

MULTI Displays the current list of open files together in one graph.  Files can be
displayed as reference radiance, target radiance or percent reflectance.

  The following is an example of a Multi Graph:

The Multi Graph displays the Target Radiance of the files in the
File Stack versus wavelengths.  The Multi Graph can display a
maximum of sixteen scans.

PLOT SETTINGS Configures the default X-axis, line width, and marker usage.
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When Plot Settings is selected, the following dialog appears:

Min Sets the default minimum X-axis wavelength when
displaying spectral data.

Max Sets the default maximum X-axis wavelength when
displaying spectral data.

Line Width Sets the relative width of the line used to graph spectral
data.

Use Markers If checked, each data point plotted is marked by a
square box.

Cancel Exit this dialog without changing settings.

Apply Now Apply changes and keep the dialog open.

OK Apply changes and exit the dialog.

About

The About menu item displays a dialog box that provides model, the current serial number
found in the GER.INI configuration file, as well as the application’s software version.

When About is selected, the following dialog box appears:
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Note that your software version and serial number may be different from this
example.
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Section 3 – Operation
1.  Setup

Battery Pack

To use the GER 1500, install a fully charged battery pack (see Section 4 – Battery Charger).  This is
done by inserting a charged battery into the keyed battery slot located on the operating panel of the
instrument.

GPS (Optional)

In order to include GPS information in the header of scans, a compatible GPS device must be
connected to the COM 1 port on the GER 1500 (see Appendix F.) When a suitable GPS device is
connected, each data file generated by the PC Data Acquisition Software will have GPS information
recorded within the data file header.

Laser (Tripod or Hand-held)

A sighting laser is used to aid in aligning the instrument to the target to be measured.  The reference
or sample (target) should be placed to completely fill the field-of-view of the instrument.  The
sighting laser can be actuated by pressing the trigger switch on the top of the instrument.

Field of View

A field-of-view diagram is provided with the instrument and shows the relative position of the
sighting laser spot and the active field-of-view for the instrument at the distance specified on the
diagram.  If optional entrance barrels are included, these FOV diagrams will also be available.

CAUTION:  Do NOT look into the sighting laser window or laser beam.
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2.  Stand-Alone Measurement

Reflectance Measurement
A reflectance measurement takes the scan of a reference (white plate) and ratios the target scan to
that reference.  If any of the below conditions exist, a reference measurement should be taken before
a series of target measurements.

• Beginning of a new set of scans

• Change in the collection optics

• Instrument has been idle or turned off for an extended period

• Lighting conditions change

When in doubt, take a reference measurement.

Taking a REFERENCE Measurement

(1) Press the power switch; the LED Power Indicator illuminates indicating that the power
is enabled.

(2) Use the up-arrow or down-arrow to obtain the REF x.xx scan message on the LCD.
(x.xx indicates voltage) Check to see if battery is properly charged.

(3) Place a reference at the point of measurement making sure to completely fill the field-
of-view of the instrument. (The optional Spectralon® plate is recommended for this
purpose.)  This reference measurement is associated with all succeeding measurements
until a new reference measurement is established.

(4) Press the trigger switch making sure to sight the reference plate as required.  (The laser
sighting is activated when the proper TRG mode is selected.) See Section 1 -
Spectroradiometer.

(5) Release the trigger switch to record the measurement.  The counter increments to
display the next available memory location.

Taking a TARGET Measurement

(1) Use the up-arrow or down-arrow until TAR x.xx (See Section 1 - Spectroradiometer.)
appears on the LCD display.

(2) Place the target/sample to be measured so that it completely fills the field-of-view of
the instrument.  Lighting conditions should agree with the reference measurement
conditions.

(3) Press the trigger switch to activate the sighting laser and verify that the placement of
the target to be measured is correct.

(4) Release the trigger switch and the measurement is recorded and the counter increments
to display the next available memory location.

 Additional target measurements may be made by pressing and releasing the trigger switch.
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Downloading Data

To view and analyze the data recorded in the stand alone mode, the data must be downloaded from
the memory of the GER 1500 to the memory of the computer.

Turn the instrument power off and connect the supplied cable between the COM2 of the instrument
and the associated control port of the computer

The downloading procedure is described in the Read Memory menu selection of the control menu in
the PC Data Acquisition Software section.

3. Computer Measurement
Connect the computer as previously described.

NOTE: On some revisions of the GER 1500 hardware, the POWER switch must be turned ON
(red LED illuminated) prior to connecting the serial cable to the GER 1500’s COM2 port.

Turn on the computer and startup the GER 1500 PC Data Acquisition Software (See Section 2 – PC
Data Acquisition Software.)

Check the battery level by clicking on control, then system voltages.

Select measurement from the control menu.  The window appears with reference and target buttons.
Click on the reference button for a reference scan and the target button for a target scan.

A reference scan should always precede a series of target scans.  Depending upon how variable the
conditions are, reference scans should be taken more frequently.  When in doubt, take a reference scan.

The scans can be displayed as a single graph or as a multi graph; acquired data may be stored to disk
in various formats. See Section 2 – PC Data Acquisition Software for complete details.
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Section 4 – Battery Charger

1. Introduction
The battery charger charges one (1) or two (2) SMARTPACK batteries simultaneously.  The charger
operates from twelve (12) volts DC.  This can be obtained from 115 or 230 volt AC line voltage using
the AC Adapter Unit provided or from an US manufactured automobile cigarette lighter using the
optional adapter.

2. Operation
1.  The two pronged AC plug of the AC adapter is plugged into a wall socket and the DC output plug
of the AC adapter is plugged into the connector in back of the battery charger as shown in the next
figure.

2.  Insert batteries into the charging bays.  The battery slots are keyed so the batteries can only be
inserted in the proper orientation.

3.  Turn on the power to the battery charger using the power switch.  The green LOCK indicator’s
LED illuminates, indicting that a battery is properly inserted in each bay.  Battery charging now
begins.  This is indicated by the red STATUS LED is being illuminated.

4.  There are three different charge cycles listed below:

      Fast Charge Cycle

The batteries are first charged using a fast charge cycle.  This operation takes approximately two (2)
hours on a discharged battery.  After the fast charge cycle the batteries are usable, but they have not
reached full capacity.

     Top-off Charge Cycle

The charger then enters the top-off charge cycle.  This lasts for about five (5) hours and ensures that
the batteries are charged to full capacity.   At this time, the STATUS LED's are no longer illuminated.
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Pulse-trickle Charge Cycle

Lastly, if the batteries are fully charged, the battery charger enters the pulse-trickle charge cycle.  This
cycle compensates for the self-discharge characteristics of NiMH batteries by periodically supplying a
charge pulse.  This allows the batteries to remain at full capacity.

5.  Remove batteries from battery charger for GER 1500 operations.
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Appendix A

SPECIFICATIONS
 
  Spectral Range 350 nm to 1050 nm
 
 Number of Channels 512
 
 Type of Sensor Silicon Array
 
 Resolution 3 nm FWHM (Full Width Half Maximum)
 
 Integration Speed 5 - 160 ms
 
 Unit Size 6" wide, 3.25" high, 10.25" long

15 cm. wide, 8 cm. high, 26 cm. long
 

Unit Weight 4 lbs. (1.8 kg.) maximum
 
 Internal Memory 470 scans maximum
 
 Sighting Diode laser at 635 nm
 
 Power 6 Volt rechargeable nickel metal hydride battery
 
 Display LCD, 8 digits, 2 rows

Laser and Power LEDs
Real Time Spectral display with computer

 
 I/Os COM1, COM2 (RS232 serial ports)

 
Options: Foreoptics Standard (4° Nominal)

Fiber Optic
8° FOV
Diffuser
(Other custom foreoptics are available on request)
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Appendix B
_______________________________

FILE DESCRIPTIONS

Signature File Format

The GER proprietary file format contains a header that includes:

1. File Format specifier
2. Title of file
3. Instrument Model and Serial Number
4. GER 1500 Internal Date and Time at Acquisition of target, reference
5. GPS Longitude at Acquisition of target, reference
6. GPS Latitude at Acquisition of target, reference
7. GPS Time at Acquisition of target, reference
8. Comments
9. Memory slot of target, reference if required in stand alone mode
10. Averaging parameter of target, reference
11. Integration speed of target, reference
12. Optic used

Note that the GPS information in the header is only available when an optional external GPS data source is connected
to the GER 1500. When present, the GPS components have the following format:

GPS Longitude DDDmm.mmmmC
GPS Latitude DDmm.mmmmC
GPS Time HHmmSS.SSS

where:

D is degrees
m  is decimal minutes
C is quadrant (N, S, E, W)
H is hours (GMT, 24-hour format)
S is seconds

Note that depending on the GPS source, the exact format may vary; for example, there may be fewer significant decimal
points present for the Lat/Lon “minutes” field, or the Time “seconds” field may be truncated to contain only integral
values.

Following the header are three columns of data:

1. Wavelengths in nanometers (nm)
2. Target Radiance in W/cm²/nm/sr*10(-¹º)
3. Reference Radiance in W/cm²/nm/sr*10(-¹º)

EXAMPLE:

///GER SIGNATUR FILE///
name=gr072696.010
instrument= 1500: 2000
time=8/1/96 5:49:08 PM, 8/1/96 5:48:05 PM
long= 07351.2658W, 07351.2651W
lati= 34140.6694N, 34140.6682N
gpstime= 184904.117, 184803.122
comm= Comments appear here
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memory slot=6,3
averaging=6,6
integration speed=6,4
optic=1(Standard),1(Standard)
data=
279.94 50.22 1478.54
281.68 149.11 108158
283.42 153.77 1103.52
285.16 154.11 1118.03
286.90 159.20 1144.22
288.64 159.48 1159.18
290.38 162.87 1184.83
292.12 166.21 1199.01
293.85 167.47 1210.83
295.59 169.99 1230.28
297.32 175.51 1269.19
299.06 174.87 1259.24
300.80 179.44 1304.73
302.53 183.02 1322.11
304.26 186.17 1342.24
     .
     .
     .

Initialization File Format

The initialization file GER.INI contains information describing the instrument and its parameters.  This file must be
accurate for proper instrument operation and calibration.

EXAMPLE:

Model = 1500
Serial Number = 2006
Com port = 2
File format = 30
Averaging = 1
Si integration speed = 1
Optic = 1
Scan mode = 1

DFOV Initialization File Format

When using the Dual Field of View (DFOV) version of the GER 1500 PC Data Acquisition Software, the software
initialization file DFOV1500.INI contains information describing the instruments and their parameters.  It is used
instead of the GER.INI file when the DFOV PC Data Acquisition Software is in use.

See DFOV Software Information in Appendix G for additional DFOV instrument information.

EXAMPLE:

Model = 1500
Serial Number = 2002,2003
Com port = 4,6
File format = 30
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Averaging = 1
Si integration speed = 1
Optic = 1
Scan mode = 1

When configuring the DFOV1500.INI file, it is important to get the serial numbers and com ports of the instrument
designated as the “Target” and “Reference” in the correct order. In the example above:

• GER1500 serial number 2002, connected on the PC’s Com port 4, is the “Target” instrument.
• GER1500 serial number 2003, connected on the PC’s Com port 6, is the “Reference” instrument.

Also, when using the DFOV PC Data Acquisition Software, both sets of the instrument’s Calibration Files must be
installed in the software’s System directory.

Calibration File Formats

There are three types of supplied calibration files.

A single Wavelength Calibration file contains information that maps channel numbers to their corresponding
wavelength.

Multiple Radiance Calibration files contain information that calibrates each channel’s digital counts to a radiometric
standard. There is one Radiance Calibration file for each fore optic supplied with the GER 1500.

A single (optional) foreoptic name configuration file. This may be used to create a non-standard list of names for
custom foreoptics.

WAVELENGTH CALIBRATION FILE

Wavelengths Calibration File: WV15yyyy.CAL, where yyyy is the instrument serial number.  This file contains a single
column of ASCII data that represents the center wavelength of detector element. There are 512 entries in this file,
corresponding to the 512 channels.

EXAMPLE (truncated):

279.94
281.68
283.42
285.16
286.90
288.64
290.38
292.12
293.85
295.59
297.32
299.06
300.80
302.53
304.26
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RADIOMETRIC CALIBRATION FILES

Radiance Calibration File names are of the form “Rx15yyyy.cal”, where
• “yyyy” is the instrument serial number
• “x” represents the entrance optic number (1 through 12) selected, as follows:

 For entrance optic numbers 1-9, “x” is the character “1” through “9”
 For entrance optic numbers 10-12, “x” is the character “A” through “C”

The number of Radiance Calibration Files supplied with each instrument will vary according to the actual number of
standard and custom foreoptics supplied with the instrument.

Radiance Calibration Files contain a single column of ASCII data that contains a conversion factor from digital counts
to Radiance (or Irradiance, in the case of the Diffuser). There are 512 entries in each file, corresponding to the 512
channels.

EXAMPLE (truncated):

0.000105
0.000106
0.000109
0.000111
0.000114
0.000115
0.000118
0.000124
0.000122
0.000124
0.000128

SPECIAL FOREOPTIC NUMBERS

One foreoptic is treated specially by the Data Acquisition Software.

• Foreoptic #5 is reserved for the  “Unity Function” foreoptic. Data gathered using this special foreoptic are not
converted to radiance values; instead, they are written as raw detector data to SIG and ASCII output files.

All other foreoptics directly apply the values found in the corresponding Radiance Calibration File, converting the data
to radiance, prior to writing output files.
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CUSTOM FOREOPTIC NAME CONFIGURATION FILE

An optional configuration file may be used to customize the number, and the names, of the foreoptics supplied with a
GER1500. The file name is “foreoptics.cal”. In order to take effect, a file with that name must appear in the installed
software’s “System” folder. If this file is not installed, the software uses the standard 5 fore-optic list.

The file is an ASCII text file, with the following format:
• The first line contains a single number in the range 1-12; this number represents the total number of foreoptic to

be found on subsequent lines.
• The remaining lines in the file contain a list of custom foreoptic names, one per line. The first name corresponds

to Optic #1, the second name to Optic #2, etc. Each name may be up to 16 characters in length.

EXAMPLE (defines a unit with 7 foreoptics):

7
Standard
Fiber Optic
8 Degree
Diffuser
Unity Function
Standard UW
4 Degree UW

GER1500pda Configuration File

The GER1500pda software requires an initialization file (in addition to the normal GER.INI file described above). The
file name is gerpda.txt, and it must be found in the PDA folder “\My Document\GERsystem” (along with all of the
other System files that are normally supplied with the instrument).

The gerpda.txt file contains information specific to the PDA installation. An example gerpda.ini file is shown below.
Comments in the file are denoted by a starting “pound sign” (#) character.

The only parameters currently in use in this file are used to setup the PDA’s internal GPS (if installed).

#         FILE: gerpda.txt
# PDA parameters are case-sensitive, and
#  MUST conform EXACTLY to the formats:
#    "Com port GPS = x"
#    "Baud GPS = yyyy"
#
# NOTE that using an illegal COM port
#  number of 0 (zero) will disable the PDA's
#  (internal) GPS, and force the software to
#  use the GER1500's (external) GPS instead.
#
# The Holux GM-271 internal GPS normally
#  installs itself on a MicrOFlex 2240X
#  as:
#     COM port GPS = 2
#
Com port GPS = 2
Baud GPS = 4800
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Appendix C

Troubleshooting

Spectrometer Head

Problem No spectroradiometer response (unable to take a reference or a target scan)

Check If the power indicator is illuminated, check the battery voltage indication by using
either the up and down arrows.  (It must be above 6.0 volts for proper instrument
operation,)

Problem **SAT** comes up on the indicator for a measurement scan.

Check Check INTSP parameter for automatic operation.  This resets the integration time
and takes the detector out of saturation.  The integration speed is discussed in
Section 1 - Spectroradiometer Description.

Problem  The measurement is not consistent with predicted values.

Check Check the entrance optic setting.  This can be done from the edit mode of the
instrument with the optic function or in the computer assisted operation from the
setup selection in the control menu.

Problem There is no response in the computer assisted operation.

Check Check the COM2 spectroradiometer port to make sure that it is used to connect
the spectroradiometer to the computer. Check the control->setup menu “Port”
setting to make sure that the correct PC COM port number is being used by the
PC software.

If the trouble still persists go to the setup selection in the control menu and check that the proper computer
port is being used.  Reset the port if necessary.

PDA GPS Data

Problem The Ctrl->Get GPS display remains blank. (Note that normal satellite lock on a
clear day with good sky visibility takes between 2 and 10 minutes after initial power
up.)

Check When using the Holux model GM-271 internal PDA receiver, use the PDA utility
“GPS Viewer” found in the PDA’s Start->Programs menu in order to debug the
GPS. The documentation for this program can be found in a folder called “GPS
Viewer Docs” within the PDA software’s installation directory (typically
“C:\Program Files\Spectra Vista\GER1500pda\”). The GPS Viewer program
(mGpsCmd.exe) allows you to Scan for the correct PDA COM port setting, and
provides a graphical display of position/satellite lock status.

IMPORTANT: When switching between the mGpsCmd utility and the
GER1500pda program, be sure to Soft Boot the PDA, as both programs may
attempt to open the same PDA COM port.

If the GPS Viewer appears to display correct data, check that the PDA COM port
that the program uses is the same as configured in the GER1500pda configuration
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file “gerpda.txt”. See Appendix B - GER1500pda Configuration File for more
information.

PDA Bluetooth – Cannot Connect To GER1500

Problem You are unable to control the GER1500 using the PDA’s bluetooth connection.

Check The PDA’s bluetooth “virtual COM port” is generally COM8 when the default
hardware is installed in the DAP 2240X PDA under the Windows Mobile 5.0
operating system.

To verify the actual Bluetooth COM port number that should be used by the
GER1500pda software, from the PDA’s Main screen, tap the following menus:

Start->Settings->Connections Tab->Bluetooth->COM Ports Tab

The following screen should appear:

If your PDA screen look similar (the GER1500-xxxx serial number may be
different), then use the COM port shown when connecting the ger1500pda
software via Bluetooth – COM8 in the example above.

If you do not see a GER1500 connection listed, then proceed to Appendix I, PDA
Software / Bluetooth Configuration Procedure in order to configure the PDA’s
bluetooth interface for use with the GER1500.

If you do see the GER1500 connection listed, and the communication problem is
not fixed by a PDA Soft Boot (See PDA Soft Reset Procedure – M2240X in
Appendix L), then try deleting GER1500 entries from the “COM Port” and
“Devices” tabs (above), and then following the procedure found in PDA Software /
Bluetooth Configuration Procedure in order to re-associated and re-establish the PDA
Bluetooth GER1500 configuration.
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Appendix D
Laser Safety

DANGER

CAUTION

The GER 1500 uses a Class IIIa laser beam.  Class IIIa lasers comply with the
requirements outlined in the USA's FDA specifications 21 CFR Chapter 1, Parts
1040.10 and 1040C.11.  The source of laser energy in the GER 1500 is a nominal 2
mw (maximum 3.5 mw peak): continuous 635 nm diode laser.  No maintenance is
required in order to keep this product in compliance with the above specifications.

Do not look into the laser beam at any time including instrument setup or operation.

Use of controls, adjustments, or procedures other than those specified herein may
result in hazardous radiation exposure.

There are no serviceable components within this device.  The unit should be
returned to the manufacturer in case of malfunction.

Labeling

(1) Certification Label

The following labels are required for the GER 1500.  The location of these labels is
indicated on the following diagram.  If the GER 1500 does not have the appropriate
labels, contact manufacturer to ensure that your unit is in compliance with 21 CFR
Subchapter J Part 1040.10.

Laser Product Conforms to 21 CFR Subchapter J Part 1040.10

(2) Warning Logotype
DANGER - Laser Radiation Avoid Direct Eye Exposure
Class IIIa Laser Product

(3) Aperture Label AVOID EXPOSURE - Laser visible radiation is emitted from this aperture

(4) Protective Housing
     Label

DANGER - Laser Visible Radiation When Open
AVOID DIRECT EXPOSURE TO BEAM
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Appendix E
CE Conformance

The GER 1500 has been tested by the Retlif Testing Laboratories in Ronkonkoma, NY and
is in compliance with the following European Requirements:

    Emissions       Requirements EN 50081-1:1992

   EN 55022:1994

   Paragraph 4, Class B Conducted Emissions 150 KHz to 30 MHz

   Paragraph 5, Class B Radiated Emissions 30 MHz to 1 GHz

    Immunity Requirements EN 50082-1:1992

   EN801-2:1984          Electrostatic Discharge

   EN801-3:1984          Radiated Immunity

  EN801-4:1988          EFT, Power Leads

   EN801-4:1988          EFT, I/O Leads
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Appendix F
GPS Input Specification

The GER 1500 accepts and records GPS information presented on its COM1 input. The
GER1500pda software (option) also reads GPS data from a card inserted into the PDA’s
internal card slot.

In order to be accepted, the GPS information must conform to the following specification:

Signal Levels       The GER1500 accepts EIA RS-232 Standard signal levels. The GPS device connects to the
GER 1500 COM 1 port via the following pins:

Signal Name GER 1500 COM 1
(Standard)

GER 1500 COM 1
(Modified For Use With

The Underwater Housing
Option)

GPS Data Tx Pin 2 Pin 8
Signal Ground Pin 5 Pin 5

All other pins on the COM 1 port must be left un-connected for proper operation.

Serial Settings       The GPS device must be configured to transmit data with the following serial settings:

4800 Baud, 8 data bits, no parity, 1 stop bit

Protocol Support       The GER1500 accepts NMEA V1.5 and V2.1 format data sentences. The following NMEA
sentence types are received and interpreted:

GPGLL
GPGGA

All other NMEA sentences are ignored.

Examples of acceptable GPGLL and GPGGA sentences:

$GPGLL,4140.67,N,07351.27,W
$GPGLL,4140.6694,N,07351.2658,W,184904.117,A*24
$GPGGA,202826,4146.5358,N,07341.8315,W,1,05,02.0,+00137,M,,M,,,*6B

Note that NMEA V2.1 is the preferred data format, since some V1.5 data sources have
lower resolution on the latitude/longitude fields, and may not contain a time field.
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Appendix G
DFOV Software Information
The GER 1500 may optionally be purchased with a Dual Field of View (DFOV) option that allows, under computer
control, near simultaneous acquisition of Reference and Target data. Two GER 1500 instruments are required.

Differences between the standard and DFOV PC Data Acquisition Software are highlighted in this appendix.

Initialization File       The DFOV software reads initialization information from the file DFOV1500.ini, instead of
GER.ini. See DFOV Initialization File Format in Appendix B for the format of this file.

Program File Name The DFOV software executable file name is “Ger1500DFOV.exe”; the standard software
file name is “Ger1500.exe”.

Installation Directory The default DFOV software installation directory is:
 C:\Program Files\Spectra Vista\Ger1500 DFOV\

Calibration Files Both (Target instrument and Reference instrument) sets of radiometric and wavelength
calibration files must be placed in the software’s System directory.

Setup Menu The PC Data Acquisition Software’s Control->Setup menu has an extra set of Computer
Port settings (see below), since two PC communication ports are required.

In addition, note that any Spectroradiometer settings are applied to both the target and
reference instruments whenever the “OK” button is pressed.

Read Memory The Read Memory function has been disabled. Stand-alone acquisition of DFOV spectral
data is not supported.

System Voltages The System Voltages command will display each instruments information in turn.
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Reference Button The Reference button has been disabled; use the Target button only to cause the near-
simultaneous acquisition of spectral data.

About The About menu item will identify the software and connected instruments as shown below:
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Appendix H
GER 1500pda Data Acquisition Software

Overview

This appendix documents the usage of GER 1500pda data collection software application on a PDA (Personal Digital
Assistant) using Microsoft Windows Mobile 2003 for Pocket PC operating system. The application will be referred to as
just “the PDA application” or “1500pda” throughout this appendix.

The main features and functionality of the PDA application are similar to that of its counterpart on the PC. It collects
data from a GER 1500 hand held spectroradiometer, saves the data to the PDA’s internal memory, and displays the
graph in different views and scales.

For general knowledge about the GER 1500 spectroradiometer, please consult the earlier sections of this manual.

Information regarding the PDA, outside of its specific use with the GER 1500 may be found in the PDA
manufacturer’s User Guide.

PDA Requirements

PDA Type: Pocket PC

Operating System: Microsoft Windows Mobile 5.0 for Pocket PC.

Interfaces: RS-232 or Bluetooth serial port
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GER 1500pda Software Installation
The GER1500pda application is pre-installed on the SVC-supplied PDA. No installation is normally
necessary.

GER 1500pda Software – Quick Reference

Start-up

1. Connect the RS-232 serial cable to the com2 port on the GER 1500 spectroradiometer.

2. Connect the other end of the RS-232 serial cable to the Serial Port on the Pocket PC.

3. Turn on power to the GER 1500 spectroradiometer.

4. Turn on power to the Pocket PC using its On/Off button.

Tap the “Start” button bar with the stylus or your fingertip and select “GER1500pda” from the menu.
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Operation

TAKING DATA

Tap the left side of the screen with the stylus or your fingertip to take a reference measurement. The user can
also tap “Control”, “Get Reference”. Tap the right side of the screen with the stylus or your fingertip
to take a target measurement. The user can also tap “Control”, “Get Target”.

QUICK VIEW OF THE DATA

Select “Plot” from the menu on the bottom and select either “Target”, “Reference”, or
“Reflectance”.

Analyzing the data

Transfer the SIG format data files from the Pocket PC to the Host PC via the ActiveSync software.  The SIG
format files may then be opened and displayed by GER 1500 PC Data Acquisition Software application.
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GER 1500pda Software Application – Usage

Introduction

This application is based on the interface and functionality of the existing PC Data Acquisition Software for the GER
1500 spectroradiometer. The GER 1500pda application runs on the Microsoft Windows Mobile 2003 for Pocket PC
operating system.

File Naming Conventions

File naming conventions are identical to its PC counterpart. Calibration files have file extension CAL. SIG Data files
have the extension SIG. ACSII data files have the extension ASC.

Startup

On the Pocket PC press the On/Off button. The GER1500pda application can be started by tapping the “Start” menu
and selecting the “GER1500pda” program, as shown below:

Operation

The menu bar for the GER 1500pda application is located at the bottom of the window. There are three or four menu
buttons on the menu bar named from left to right as “File”, “Plot”, and “Ctrl. There are also up to four menu
icons that, from left to right each represents “Ctrl=>Get Target”, “File=>Open File…”, and
“File=>File Base Name”.
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The initial GER1500pda screen is shown above. In addition to the menus described above, this screenshot
shows the “hot” areas of the screen that may be tapped in order to acquire new reference or target data from
the instrument when in “One-Touch Scan” mode.

The following sections describe the various functions available in the main menu.

MENU BUTTON “FILE”

The dropdown menu list for the “File” consists of the following menu items:

Folder     Displays a dialog for a user to create a new folder or delete a selected empty folder.
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Open File…     Displays a dialog for a user to select and open an existing SIG file for display.

Delete File… Displays a dialog for a user to select and delete a file generated by the GER
1500pda application.

File Base Name Displays a dialog for a user to specify an optional base file name, i.e., the first part
of a file name. This is used with “Auto Save” mode (see “File=>Auto
Save” below). The default base file name is set to be identical to that of the PC
counterpart. The format is “GRmmddyy” where mm is the month dd is the day and yy
is the year. When Auto Save is used the Base File name is extended with “_num”
where num is an automatically incremented, unique number that starts at “001”
and ends at “999”.
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File Contents This displays a dialog for a user to choose whether the retrieved data should be
saved into a SIG File or a user defined ASCII text file.

Comment A text field is saved in the file when either format is selected.

• Sig File This is the format compatible with the GER1500 PC
Data Acquisition software;  spectral data saved in this
format may be read back and displayed at some future
time by the GER1500 PC Data Acquisition Software

• Ascii File  Check the column(s) of data that will appear in the ASCII
data file. The options are:

Header  Information, including instrument settings, date/time,
etc.

Wavelength  In nanometers

Reference Radiance in W/cm2/nm/sr*1010

Target Radiance in W/cm2/nm/sr*1010

Reflectance Percent

OK Implements the selected file format and exits the dialog
box.

Cancel Ignores the modifications made to the file format and exits the
dialog box.
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Auto Save This is used to enable or disable (dot or no dot next to entry) “Auto Save” mode. By default
“Auto Save” file-saving mode is enabled. When “Auto Save” mode is selected, the
application will save the acquired data into a file with the specified base file name and
append the auto incrementing unique number before the file extension. See “File Base
Name” above. “Auto Save” and “Prompt Save” modes are mutually exclusive.

Prompt Save This function is disabled.

About… Display program version information.
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MENU BUTTON “PLOT”

The dropdown menu list for the “Plot” is composed of the following menu items:

Reference Set the graphic display mode to “Reference”. This mode has no effect when
the graphic display type is set to “Mixed”. The target data will be plotted in black
.

Target Set the graphic display mode to “Target”. This mode has no effect when the
graphic display type is set to “Mixed”. The target data will be plotted in red.

Reflectance Set the graphic display mode to “Reflectance”. This mode has no effect when
the graphic display type is set to “Mixed”. The target data will be plotted in blue.

Single Graph Set the graphic display type to plot one data set of the data type target, reference,
or reflectance as determined by the graphic display mode.

Mixed Graph Set the graphic display type to plot all the “Target”, “Reference” and
“Reflectance” data together in red, black, and blue, respectively.

Multiple Graph Set the graphic display type to plot a maximum of ten sets of the target, reference,
or reflectance data, as determined by the graphic display mode.
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Plot Axis The “Default” radio button will scale the entire data set(s) onto the window.
By selecting the “Manual” radio button the graph will display a specific region
defined by the minimum and maximum X- and Y- coordinate values specified.

Graph Header This displays the SIG file header information in the bottom of the window.
Additional functionality depends on the graph mode.

Single Graph Display Type Header information from data available in the
application’s memory will be displayed.

Multiple Graph Display Type A popup menu list will be displayed for the user to
select which file’s header information to display.
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Erase Current Graph / Erase All Graphs

Single and Mixed Graph Display Type

When selected it will clear the data graphic display.

Multiple Graph Display Type

When selected it will remove the top file on the file stack from the data
graphic display.
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MENU BUTTON “CTRL” (CONTROL)

The dropdown menu list for “Control” has the following menu items:

Setup Instrument The setup dialog has the numerical field “Timer Duration” to
specify a time delay, in seconds, before the next scan. The “Time” and
“Date” fields show the PDA’s current time and date settings; these
settings are used when recording the time/date of a scan initiated by the
PDA software. The remaining “Entrance Optic” and
“Averaging” fields are used for configuring the GER 1500
spectroradiometer. The integration setting is read from the instrument.
Refer to the PC document for their technical description or usage.
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Time Off / Timer On The default mode is set to “Time Off”. When toggled to “Time On”
with a valid “Timer Duration” value set(see “Control=>Setup”
above), the application will collect the target data repetitively with a delay
of a user specified time between each scan.

Setup Com Port Allows the operator to choose which of the PDA’s
COM ports should be used to communicate with the
GER 1500 instrument (see below). The PDA’s RS-
232 DB9-style connector is usually COM1. The
optional Bluetooth port is configuration
dependant, and may usually be found on COM8 or
COM9.

Tap the “Test Selected COM Port” button to test
the communication link to the GER 1500
instrument using the selected COM port. Note
that if a Bluetooth COM port is selected, you
may be prompted to find/select a GER 1500
Bluetooth device.

Tap the “OK” button to permanently save the
selected COM port to the GER.INI configuration
file.

Tap the “Cancel” button to exit the dialog
without saving any changes.

Get Reference This initiates a reference measurement and retrieves the reference data
from the GER 1500 spectroradiometer and updates the file “\My
Documents\GERsystem\reference” with the data. Tapping any
region on the left side of the window will cause the window title caption
to change to “Taking a Reference…” informing a user that the
application is in the process of initiating and retrieving the reference data
from a GER 1500 spectroradiometer. Also see related issue in
“Control=>One-Touch Scan ON”.
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Get Target Initiates a target measurement, retrieves the target data from a GER 1500
spectroradiometer and displays the data in the selected graphing mode
and type. Tapping any region on the right side of the window will cause
the window title bar to change to “Taking a target…” informing a
user that the application is in the process of retrieving the target data
from a GER 1500 spectroradiometer. Also see related issue in
“Control=>One-Touch Scan ON”. Note:  A data file is created
only after a reference measurement and a target measurement are made.
The data file is created in the “\My Documents\GERdata\” folder.

Get Menu Retrieves and displays the current menu settings from a GER 1500
spectroradiometer. Note: the integration settings in PDA operational
mode are taken from the instrument.
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Get Voltage Retrieve and display the current voltage data from a GER 1500
spectroradiometer.
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Get GPS Returns the current GPS coordinates from either the PDA internal GPS
source, or the GER1500 externally connected GPS source. If the
coordinates are blank, then either there is no source for GPS data
installed, or the GPS device has not locked onto enough satellites to
compute a position.

The window displays “External GPS Info” in the title bar when
configured to use the GER1500’s External (COM 1) as a source; the title
bar displays “Internal GPS Info” when configured to use the PDA’s
internal GPS receiver as a source. See Appendix B - GER1500pda
Configuration File for configuration and trouble-shooting instructions.

Prior to a good satellite lock, the Latitude, Longitude, and Time fields are
blank; tapping the “Retry” button will update the fields with new GPS
data (if available). Tapping the “Cancel” button will dismiss the dialog
box.

Beep On No GPS Data When checked, the PDA will beep as each reference/target scan is
acquired, if the selected GPS source is not producing coordinates (either
because the GPS device is not installed, or the device has not yet
computed a position.)

One-Touch Scan ON The default setting “One-Touch Scan ON” indicates that the quick
window-tapping method for data collection is in effect. Selecting this
menu option will toggle the setting to “One-Touch Scan OFF” to
disable the window-tapping. See sections ”Get Reference” and
“Get Target” for details.
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Appendix I
GER1500pda Software Installation From CD

Follow the procedure below in order to load the GER1500 PDA Data Acquisition Software from the supplied
CD onto the PDA device. The CD is labeled “GER1500 PDA Data Acquisition Software Installation”.

The procedure requires a Windows XP machine with a CD and USB port. The Microsoft ActiveSync software
(supplied by the PDA manufacturer on CD, or downloadable from Microsoft) must be installed on the
Windows XP machine.

The installation process uses the Windows ActiveSync software and the USB connection to automatically load
programs and data from the installation CD to the PDA.

PDA Software Installation Procedure

This Software Installation Procedure supports the following PDA models and PDA operating systems:

• DAP model MicroFlex M2240X, Windows Mobile 5.0 OS

1. Perform a Hard Reset of the PDA according to the instructions found in Appendix L. Note that a Hard
Reset wipes out all previously installed programs, and all acquired spectral data. You should see a
screen similar to the one below after the PDA has completed the reset:

2. Connect the PDA to the Windows XP machine using a USB cable. An “ActiveSync” window should
appear on the Windows XP display. Use this “ActiveSync” window to establish a “Guest Partnership”
between the PDA and XP, using a dialog window similar to the one shown below:
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3. Press the “Next button”, to complete the ActiveSync connection between the PDA and Windows XP
machine.

4. Now insert the “GER1500 PDA Data Acquisition Software Installation” CD into the Windows XP
machine. The following screen should appear on the XP machine’s display:
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5. Press the “Next >” button to get to a “Readme” screen that contains special post-installation instructions.
As noted in the “Readme”, you must manually move some files from your instrument’s “System” folder
to the PDA before running the GER1500pda program:

6. Press the “Next >” button to get to the Destination Folder installation screen. The installation program
places some program information onto the Windows XP machine prior to sending it to the PDA, and the
Destination Folder holds that program information:
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7. Press the “Next >” button to get to Ready To Install Screen:

8. Press the “Install” button to begin installing the PDA software. After the installation has copied some
information to the Windows XP machine’s hard disk, you will see the following dialog:

9. Press the “Yes” button to begin downloading the GER1500pda software to the PDA via ActiveSync.
When the download is complete, you should see the following message on the Windows XP  display:
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10. There are no additional steps;  press the “OK” button to proceed. You should see the following “Wizard
Complete” message on the Windows XP display:

11. Press the “Finish” button, and proceed to the next section, Copying Your Instrument’s System Folder To
The PDA.
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Copying Your Instrument’s System Folder To The PDA

1. After the software installation, you must copy the contents of your GER1500 “System” folder from the
Calibration CD provided with each GER1500, into the PDA’s “GERsystem” folder, using the ActiveSync
connection. To do this, on the Windows PC, open the “My Computer”->”Mobile Device” view using
Windows Explorer:

2. Use the Windows PC Explorer window to navigate into the “GERsystem” folder view (shown below).
After installation, this directory only contains the single PDA configuration file “gerpda.txt”; we must
copy over the serial-number specific configuration files supplied on CD into this “GERsystem” folder:

3. Insert the GER1500 “Calibration Disk” CD that was supplied with your serial number instrument; open
the CD using another Windows Explorer window:

4. As shown, select and copy the highlighted files from the CD into the “GERsystem” folder. The file names
shown above will vary somewhat from your installation, as the calibration file names contain a particular
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instrument’s serial number as part of their file name. See the PDA’s “File Explorer” view of the \My
Documents\GERsystem” folder below for a view on how a typical GERsystem directory appears on a
PDA:

Note that in the above example, the default number of optics (five) is in use, so the radiance calibration files
are numbered R115xxxx.cal through R515xxxx.cal. If your instrument includes customizations to either the
number or names of the foreoptics, then your system folder would also contain:

• Additional radiance calibration files, R615xxxx.cal, R715xxxx.cal, etc. as needed.

• An additional configuration file “foreoptics.cal” which lists the custom foreoptic names.

See Appendix B, FILE DESCRIPTIONS, Custom Foreoptic Configuration for more information.

The software and system folder installation is now complete. Proceed to the next section, PDA Software /
Bluetooth Configuration Procedure, which shows how to initially configure the Windows Bluetooth driver
software for use with the ger1500pda software.
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PDA Software / Bluetooth Configuration Procedure

After the GER1500pda application installation, the PDA’s Bluetooth drivers must be configured to operate
with the GER1500pda software. This is done by first associating the PDA with the GER1500’s bluetooth
connection, and then configuring a bluetooth COM port connection. This is detailed in the procedure below.

1. With the GER1500 instrument powered off, install the Socket Bluetooth Adapter onto the “COM2” port
of the GER1500 (See Appendix K, GER 1500 Optional COM2 Bluetooth Adapter for more
information).

2. Turn on the GER1500 instrument by pressing the “POWER” membrane switch, located on the
instrument’s front control panel. With power applied, the Socket Bluetooth Adapter’s blue LED should
begin blinking.

3. From the PDA’s main initial screen, tap the Bluetooth Control Tool shortcut (shown below) to begin
configuring a bluetooth connection between the PDA and the GER1500 insrument:

4. The following screen appears:
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5. Tap the “Menu” button, then “Bluetooth Settings” popup button; the following screen appears:

6. Ensure the that the checkboxes are as shown above, then tap the “Devices” tab at the bottom of the
screen; the following screen appears:
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7. Tap the “New Partnership…” text line; after searching and finding the GER1500 bluetooth device, the
following screen appears:

8. Note that the instrument serial number (2028 in the example above) will vary from installation to
installation. Select (by tapping) the GER1500 device shown, and tap the “Next” button; the following
screen appears:
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9. Tap the keyboard keys in order to enter the seven character Passkey “ger1500” into the text box. Be sure
to enter the Passkey exactly as shown (lower case) because the Passkey is case sensitive. Press the “Next”
button, and the following screen appears:

10. Ensure that the “Serial Port” service is checked, and tap the “Finish” button; the following screen
appears:
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11. Tap the “COM Ports” tab at the bottom of the screen; the following screen appears:

12. Tap the “New Outgoing Port” text line; the following screen will appear:
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13. Tap on the GER1500 device so that it is selected, and tap the “Next” button; the following screen will
appear:

14. Note the COM port that is selected for the GER1500 connection. Note also that the “Secure
Connection” checkbox is NOT checked. Tap the “Finish” button; the following screen is displayed:
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15. Tap the “OK” button in the upper right; the following screen will appear:

16. Tap the “Done” button in the lower left. The GER1500 bluetooth COM port configuration is now
complete.

The GER1500pda application may now access the GER1500 instrument via its Socket Bluetooth
Adapter. The GER1500pda application can select the configured bluetooth COM port by using the
GER1500pda menu’s “Ctrl”->”Setup COM Port” screen. The COM port selected must match COM
port shown in step 14 above (COM8 in this example) in order to use the bluetooth connection to
acquire spectral data.
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Appendix J
USB / Serial Adapter Guidelines

The optional USB Serial Adapter converts a PC’s USB port into a 9-pin RS-232 serial port, suitable
for connecting a GER 1500 to a Windows PC.

Instructions

1. Install included USB/Serial software on your PC computer, from the CD provided by the USB/Serial device
manufacturer.

2. Plug the USB Serial Adapter into your PC computer’s USB port.

3. Connect the USB Serial Adapter to the 3-meter communications cable.

4. Turn on power on the GER 1500.

5. Attach the 3-meter communications cable to the COM2 port of the GER 1500.

6. You are now ready to take measurements. Refer to Section 3 – Operation - subsection 3. Computer Measurement.
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Appendix K
GER 1500 Optional COM2 Bluetooth Adapter

The optional COM2 Bluetooth Adapter allows the GER 1500 to communicate wirelessly with a
Windows PC or PDA. The adapter is installed on the COM2 port on the GER 1500 instrument in
place of the 9-pin serial RS-232 cable.

The COM2 Bluetooth Adapter can only be installed on GER 1500 instruments that have been
modified for use with the adapter. Two models are shown below. Contact SVC for more
information.

**** WARNING ****
The COM2 Bluetooth Adapter draws power directly from the GER 1500 COM2 port;
therefore, when connected to the GER 1500, the adapter must never be powered by any
external power supply!

Installation:

1. Power down the GER 1500.

2. Attach the Bluetooth Adapter to the COM2 port of the GER 1500.

3. Power up the GER 1500;  the LED mounted on the Bluetooth Adapter begins blinking.

Bluetooth Connection Information:

Bluetooth Versions Supported: V1.1

Bluetooth Class: Class II or Class I

Bluetooth Connection Type: Virtual COM Port

Bluetooth Connection Name: GER1500-xxxx, where xxxx is the serial number of the connected GER 1500.
This name is pre-programmed at SVC for use with a specific GER 1500 instrument.

Bluetooth Connection PassKey: The Bluetooth PassKey is the seven-character string “ger1500”.  Note that
the passkey string is case-sensitive.
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Appendix L
PDA Usage Tips

PDA Soft Reset Procedure – M2240X

The M2240X PDA may be Soft Reset by pressing and holding the Power Key (shown below) until
the PDA screen indicates the soft reset is in progress. Note that if the PDA is hung, the key may
have to be held down as long as 60 seconds before the soft reset takes place.

Performing a Soft Reset simply restarts the PDA operating system. It is similar to re-booting a PC.

PDA Hard Reset Procedure – M2240X

Warning: Hard Resetting the PDA will require re-installation of the GER1500pda software,
from CD. See the Appendix I GER1500pda Software Installation From CD for more details.

The M2240X PDA may be Hard Reset by:
1. Pressing and holding the Power Key (shown below) until the PDA displays a countdown.
2. Continue to hold the Power Key until it counts to zero and beeps twice.
3. Release the Power Key and immediately press and hold the Start and OK keys

simultaneously.
4. Release the Start and OK keys after about 10 seconds, and follow on-screen instructions to

complete the Hard Reset process.
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PDA Power Up

If the PDA is turned off, or automatically powers down while the ger1500pda software is in use, it
may be necessary to perform a Soft Reset on the PDA, followed by a restart the ger1500pda software.

In general, after turning on the PDA and before beginning a series of new scans with the ger1500pda
software, it is recommended that the operator always first perform a Soft Reset on the PDA.

PDA Charging

Even when not in use, the PDA should be periodically recharged every few weeks. This process
allows the PDA’s internal backup battery to maintain the ger1500pda software installation and
configuration.

Failure to maintain the charge on the PDA’s internal backup battery will cause the ger1500pda
software to be lost. In this case the ger1500pda software must be re-installed from the supplied CD.
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connecting serial cable.

3.3 Appendix H, I, K J. Saulner, L. Slomer 7/6/06 Add Appendix H and I, and modified
Appendix B for 1500pda. Added

Appendix K for Bluetooth.
3.4 Appendix C, I, L L. Slomer 3/6/07 Added Appendix L; Gutted Appendix

I for Windows Mobile 5.0 OS changes;
added PDA Bluetooth troubleshooting

information to Appendix C.
3.5 Section 1,  Appendix

H
T. Corl 7/27/07 Integration time setting clarifications.

3.6 Appendix K Slomer 11/7/07 Added new Bluetooth device.
3.7 Pages 1, 6, 21, 35-36 Slomer 1/19/08 Added description of new custom

foreoptic name list – up to 12
foreoptic names now available

(Firmware V1.7, PC Software V2.3,
PDA Software V2.3 required).


